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W e l c o m e

This user’s guide introduces you to the SignStream application. The first part of the guide
functions as a tutorial, interactively demonstrating the main capabilities of SignStream, using
the sample database that is provided with the application. The second part of the guide focuses
on particular SignStream functionalities. The guide concludes with several appendices
containing reference information.

The guide assumes that you are familiar with basic MacOS concepts (e.g., using the mouse,
manipulating files, and manipulating QuickTime movies). Although SignStream is
distributed with a database containing examples from American Sign Language (ASL), you do
not need to know ASL in order to benefit from the tutorial aspects of the guide.

About SignStream
SignStream is a multimedia database tool that assists in the transcription and analysis of
video-based language data. SignStream is being developed by researchers at Boston
University, Dartmouth College, and Gallaudet University. We are grateful for support from
the National Science Foundation (NSF grants SBR-9410562, IIS-9528985, EIA-9809340, and IIS-
9912573).

Registration
Users of SignStream are required to register with the program developers. If you have not
registered, please do so as instructed in the materials provided with the program.

For further information
On-line help is available in a number of forms. The SignStream Help command under the
Apple menu provides some basic on-line help. The SignStream program also provides help
information via “balloon help.” In addition, information about the program is available in
this guide, in the design specifications document, in other accompanying documents
provided with the SignStream program distribution (e.g., the ReadMe file and the Upgrading
file), and at our web site. The user is encouraged to consult these sources before sending
questions to the developers.

Information about the SignStream project is available on the WWW at:
http://www.bu.edu/asllrp/SignStream

http://www.bu.edu/asllrp/SignStream


SignStream User’s Guide 3 Welcome

Feedback concerning the program may be sent by e-mail to feedback@louis-xiv.bu.edu. A bug
report form is included with the SignStream distribution. Please use this form to report
problems you experience with the program, and e-mail the information to
feedback@louis-xiv.bu.edu.

mailto:feedback@louis-xiv.bu.edu
mailto:feedback@louis-xiv.bu.edu


Chapter 1: Introducing SignStream

This chapter introduces you to the main features of SignStream. The chapter utilizes the
sample database that is provided with the program.

About the sample database
The sample database contains 10 short ASL utterances. Each utterance associates a segment of
video with a transcription of the language data portrayed in the video. The video data for the
utterances in the sample database are located in two different QuickTime movie files:
utterances 1-5 are contained in set-a01.mov and utterances 6-10 are contained in set-a02.mov.
The program seamlessly integrates video data from multiple movie files, as it records where
the video segment for each utterance is located and automatically opens the correct movie file
when an utterance is opened.

Browsing the sample database
Launch the SignStream application and open the sample database (either double-click the
sample database file or launch SignStream and then select Open Database from the File
menu). (Note: it is a good idea to either lock the sample database or make a backup copy of it,
if you are not working off a CD-ROM, in case you accidentally save modifications to it.)

Opening an utterance

When you open the sample database for the first time, an index window appears. This index
contains a list of all the utterances in the database. Each utterance is identified by a number
and a portion of the text from the utterance’s main gloss field. You can use the index window
to open or delete utterances or to create new utterances. See Figure 1 on the next page.
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Figure 1: Index of utterances in the sample database

Select the second utterance from this list. The program will open both a video window, in
which the utterance’s movie file is displayed, and a gloss window, in which the utterance’s
transcription is displayed.

It is possible that the program may not be able to locate the movie file for the utterance. This
can happen if the movie file has been moved to a different location. When the program looks
for a movie file, it first looks in the location where the movie file was last known to be. If the
file is not found, the program looks in the same directory as the database file and then in the
same directory as the SignStream application. If the file is still not found, the program will ask
the user to locate the file.

If the user has had to relocate the movie file, then the program asks whether it should update
the movie information only for this particular utterance or for all utterances that point to the
same movie file. It is generally a good idea to update all the utterances that point to the same
movie file; that way, you won’t have to locate the movie file again when you go on to view
other utterances.
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It is possible to associate multiple media files (up to 4 movie files and 1 audio file) with a
single utterance. (All these media files are assumed to have synchronized frame 
numbers.)  Audio file data are displayed as an audio waveform in an audio window. 
A media controller is available for manipulating the media associated with an utterance.

The final type of window associated with an utterance is the notes window, where one can
enter textual comments about the utterance. The notes can be searched using the search
facility.

In sum, an utterance links a media segment (i.e., a segment of  1-4 movie files and of an
optional audio file, all synchronized) with a transcription (contained in a gloss window) and a
set of notes.

Navigating the database

You can open other utterances in the database in a variety of ways. Items under the Utterance
menu allow you to go quickly to the first utterance in the database, the last utterance, the next
utterance, or the previous utterance. In addition, you can open utterances from the database’s
index window (see Figure 1 on the previous page), which can be activated by selecting Open
Utterance under the Utterance menu, or by clicking the Index button found in most
windows.
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The media controller window
The media controller window (see Figure 2) provides the means for  you to manipulate the
media associated with an utterance. You can open this window by clicking on a Media button
in one of the utterance's other windows, or selecting Media Controller from the Utterance menu.

These buttons 
activate the 
associated 
windows

media player
controls

speed and 
volume
controls

frame
number

utterance id
window type database name

video file
controls

audio file 
controls

Figure 2: The media controller

The window is divided into 3 sections, based on functionality. The top part contains controls
that manipulate the play of all of the utterance's media. In the center are buttons for selecting,
opening, and displaying each of the utterance's video files. The audio section at the bottom
duplicates the video section's functionality, applied to the utterance's audio file.  Specifically:

• Index: This button opens and activates the database’s index window, bringing the index
window to the front.
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• Gloss and Notes buttons: These buttons activate the utterance’s associated gloss and
notes windows, respectively, bringing the window to the front.

• Media controls: The media controls provide standard QuickTime controls for
manipulating the media associated with an utterance. All open media are manipulated
through a single set of controls. The media player controls appear alternately in the
media controller window, video window, audio window, or gloss window, depending on
which is active. This provides easy access to the controls from each of these windows.

• Speed control: This menu allows you to change the speed at which the media play.

• Volume control: This menu allows you to change the volume at which the audio
plays.

• Frame number display: This box displays the current frame number. Note that the
compression method used in digitizing video creates distinct “real” movie frames only
when there is a change in the picture. The visible effect for the SignStream user is that
the frame numbers in the display do not necessarily advance in consecutive numerical
sequence. The frame numbers of the “virtual” frames between the “real” frames are not
displayed and cannot be accessed via any of the media controls.

Video

Several buttons are provided for manipulating each of the four possible video files that
may be associated with an utterance. Note that when multiple video files are used, the
program assumes that those video files have synchronized frame numbers (i.e., have the
same sets of frames). Use of unsynchronized files may yield unpredictable results.

• Select: This button is used to select a video file. After clicking this button, a file dialog
appears, allowing you to locate the desired QuickTime movie file. The name of the
selected file appears to the right of the buttons.

• Remove: Clicking this button will deselect the selected video file, so that it is no longer
associated with the utterance.

• Open: This button opens the video file in a video window.

• Info: This button displays information about the video file.
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Audio

The buttons in the audio section of the media controller window function in the same 
manner as the ones described above, allowing the user to select or remove an audio file,
as well as open the audio window. The audio file must be in AIFF format. SignStream 
provides a utility for converting QuickTime movie files to AIFF files; see the description
 of Create Sound File under the File menu.

Note that it is not necessary to use a separate audio file in order to hear sound playback. In
the absence of a distinct audio file, the program will play the audio track from the highest
open video in the list (if it has one). Thus, if video 1 is the open, its audio track will be
played. If video 2 is open, its audio track will be played only when video 1 is not open. In
any case, it is not possible to view the sound wave for an audio track contained within a
video.
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The video window
The video window (Figure 3) displays a QuickTime movie file associated with an utterance. In
addition to standard QuickTime controls, the video window contains several other elements.

These buttons 
activate the 
associated 
windows

utterance id
window type database name

media player controls

video frame
number

Figure 3: The video window

• Index: This button opens and activates the database’s index window, bringing the index
window to the front.

• Gloss, Media, and Notes buttons: These buttons activate the utterance’s associated gloss,
media controller, and notes windows, respectively, bringing the window to the front.

• Frame number display: This is the same frame number display as described earlier for
the media controller window.
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• Media controls: These are the same QuickTime controls described above for the media
controller window.

The Media Info menu item in the Utterance menu can be used to display a variety of types of
information about the media file, including, e.g., copyright information, data size, data rate,
and dimensions.

The audio window
The audio window, illustrated in Figure 4, displays a sound waveform (in terms of changes in
amplitude over time) for an audio file. Like other windows, it contains convenient buttons
for accessing the index, gloss, media controller, and notes windows. It also displays the current
frame number, and contains a set of media player controls. A media alignment indicator 
(discussed in more detail below) indicates the position of the current frame within the display.

These buttons 
activate the 
associated 
windows

utterance id
window type database name media player controls

frame number

media alignment indicator

Figure 4: The audio window



SignStream User’s Guide 12 Introducing SignStream

The gloss window
The transcription for an utterance is entered and manipulated in the gloss window (see Figure
5 below). The gloss window is divided vertically into two major areas. The tool area contains
two rows of controls. Below the tool area are the participant panes (one or more).

utterance id
window type database name

to
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ti

ci
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an
t 

p
an

e

media alignment indicator

Figure 5: The gloss window
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Gloss window tools

There are two rows of tools in the gloss window, as shown in Figure 6. The first row contains
buttons for activating the utterance's index, media controller, and notes windows, as well as a 
set of media player controls.

open and activate
media controller window

open and activate
notes window

media player controls

Utterance/Datum play the
selected
object(s)

go to start

go to end

end start
increment

decrementset endset startincrement

decrement
start

start

end

end

frame frame

open and activate
database index

popup menu

Figure 6: Gloss window tools

The second row contains tools for manipulating data entered into the transcription. These
tools operate on either the utterance as a whole or on data selected in a participant pane,
depending on the selection in the Utterance/Datum popup menu.

• Utterance/Datum: This popup menu determines whether operations apply to the
utterance as a whole, or to selected data within a participant pane.

• Play Clip: This button plays the media clip corresponding to the selected item or items in
the gloss window. The clip is played simultaneously in all of the utterance's open video
and audio windows. For example, to play the clip that corresponds to the utterance as a
whole, first make sure that “Utterance” is selected in the Utterance/Datum popup
menu, and then click the Play Clip button.

 You can also play the clip that corresponds to a datum in the participant pane area of
the gloss window. For example, to play the clip that corresponds to the sign HOUSE,
select HOUSE in the main gloss field (double click on the word HOUSE so that it is
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highlighted, or simply click the mouse somewhere within the word) and then click the
Play Clip button. Similarly, you can play the clip that corresponds to the raised eye
brows. To do so, first select the “raised” line within the eye brows field (when it is
selected, the line appears with “handles” at each end). Next, use the Play Clip button to
play the associated media clip.

 Note that it is currently not possible to select multiple elements within a field (e.g., by
click-dragging across multiple data items). However, you can select an entire field by
clicking on the field label at the left so that the whole field is highlighted. Play Clip will
now play a clip beginning at the start frame of the first datum and ending at the end
frame of the last datum in that field. Try selecting the main gloss field and then playing
the clip.

• |–  (go to start): Click this button to shuttle to the starting frame of the selected object(s).

• – | (go to end): Click this button to shuttle to the final frame of the selected object(s).

To see how the |–  and –| buttons function, use the Utterance/Datum popup menu to
switch to utterance mode. Then use the |–  and –| buttons to move to the beginning and
end of the utterance’s clip. Now select a datum (e.g., the gloss BUY) and use the buttons
to move to the beginning and end of its clip.

The remaining buttons and displays are used to establish the start frame and the end frame of
a selected object. Identical tools are available to manipulate an object’s start and end frame
numbers. The current start/end frame number is displayed in a box. The tools surrounding
the start frame box affect the start frame, while the tools surrounding the end frame box affect
the end frame.

The Set buttons are used to set the current media frame as the start or end frame of the selected
object. The + and – buttons increment and decrement, respectively, the start/end
frame by one significant frame. The use of these buttons is described further in Chapter 3:
Coding utterances. For now, notice that as you select a datum, the datum’s start and end frame
numbers are displayed in the appropriate boxes.

Participant panes

SignStream supports the coding of data associated with different conversational participants
(see Chapter 4: Working with multiple participants). A participant pane (see Figure 7) contains
the coded data associated with a particular participant.
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Figure 7: A participant pane

The upper portion of the participant pane contains a row of tools for manipulating that pane;
the data viewing area is located below those tools. The tools contained in each participant
pane are described below.

• Participant Identifier: This pop-up menu is used to select the participant whose data are
to be displayed in the pane. The menu’s label identifies the participant that is being
viewed. When you click on this menu, a list pops up that contains the names of all the
participants in the database; those that are active in the utterance have an asterisk preced-
ing the name and the primary participant (see below) is listed in bold. From this list you 
can select a different participant to view in the pane (one that is not already being viewed
elsewhere in the gloss window). Once you have made a selection, the participant pane
displays the data associated with the newly selected participant. The previously viewed
data (associated with the previous participant) still exist, but are no longer being
displayed.
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• Edit Participant: This button opens the participants editor, which lets you specify certain
kinds of background information about the participant.

• Show All Data: This button is active when there are fields containing data that are not
currently being displayed. Clicking the button will cause all fields that contain data to be
displayed in the participant pane.

• Show Field: Use this button to add a (previously defined) field to the display.

• Hide Field: When a field in the participant pane is active or selected (a field can be
selected by clicking on its label), clicking this button will hide that field. Any data coded
in the field are unaffected. You can use the Show Field button to view the field again.

• Hide Pane: Use this button to hide the participant pane. Not all panes can be hidden,
however; a gloss window must display at least one pane.

• Primary participant button: This button indicates whether this participant is the
primary participant for the utterance. The primary participant is considered to be the
one who is the main signer or speaker. Every utterance has exactly one primary
participant. The primary participant is displayed in bold in the participant identifier
pop-up menu.

The bulk of the participant pane is dedicated to the representation of the coded data. The data
area is divided into three regions, such that each region contains data fields of a particular
type. Manual data (e.g., signs produced by the hands) are coded in the main and non-
dominant hand gloss fields in the center region. Non-manual information (movements of
the face and upper body) is entered in fields above these gloss fields. Text-based fields (such as
the English translation field) and other gloss fields created by the user are located below the
main and non-dominant hand gloss fields.

The main and non-dominant gloss fields are always visible. Other fields can be displayed (via
the Show Field button) and hidden (via the Hide Field button, the Hide Field menu item in
the Utterance menu, or the Hide Empty Fields menu item, also in the Utterance menu) as
needed. The vertical ordering of the fields within any of the three regions can be changed by
dragging the field label (the text label on the left), and thus the entire field, to a new position.
However, it is not possible to move a field from one region to another; e.g., the “eye brows”
field cannot be moved to a position below the gloss fields.
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Media alignment indicator

The media alignment indicator is a vertical line that extends through all fields in all
participant panes in the gloss window. (A media alignment indicator also appears in the
audio window.) The position of this indicator corresponds to the position, in the
transcription, of the current media frame. As the movie plays, the media alignment indicator
moves across the gloss window. You can shuttle forward or backward through the movie by
dragging the media alignment indicator. The Media Alignment Indicator submenu in the
View menu can be used to specify whether to show or hide the media alignment indicator.

Getting information about the database
Selecting Database Info from the File menu makes it possible to view and edit information
about the database (such as its authors, modification date, and citation information).
Researchers who want to cite an example from a SignStream database should use the citation
information contained in this window, in combination with the specific utterance number.



Chapter 2: Creating a database

This chapter steps through the process of creating a database. In particular, the chapter
discusses how digital movie files are integrated into SignStream databases, and demonstrates
the process of establishing utterance boundaries. Upon completion of this chapter, you will
have created a new SignStream database containing two utterances from different movie files
(the same movie files that form the data for the sample database). In Chapter 3: Coding
utterances, you will transcribe some of the data in these utterances.

Digital video
In order to use SignStream to code video data, you must first have a QuickTime movie file
containing the data to be coded. The creation of such a movie file (involving the digitization
of video) is a separate process, which does not involve SignStream. However, we have
provided a document (available on the WWW) containing some introductory comments on
the production of digital video.

Creating a new database
Launch the SignStream application by double-clicking on the application icon. The program
creates a new “Untitled” database, and presents you with an index window and an empty gloss
window for the first utterance in the database. The gloss window contains a single participant
pane associated with the default “Participant1.”

Note that you can create a new database by selecting New Database from the File menu.
However, we will use the one that the program has already set up for us.

Defining the first utterance
The program has already created the first utterance (the first record in the database), although
the utterance is empty at this point. The first task is to link the utterance to the appropriate
movie file. To do this, first open the media controller by clicking on the Media button (or by
selecting Media Controller from the Utterance menu).

For the first utterance, we will use a single clip from the set-a01.mov movie file that was
distributed with the SignStream release. Click the Select button in the first row of the video
section of the media controller: an Open File dialog appears. Locate the set-a01.mov movie file
and click the Open button. A video window should appear showing the first frame from the

http://www.bu.edu/asllrp/SignStream/video.html
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selected movie file. (At this point, you can close the media controller if you want to get it out
of the way.) Utterance 1 is now associated with this movie file.

This particular movie file contains five isolated signed utterances (use the media controls to
play the movie and view the utterances). In general, a movie file may consist of one or more
short isolated clips or it may contain a longer stream of data, e.g., a conversation or narrative.
It is up to the researcher to decide how to organize the contents of a movie file. In addition,
the researcher must decide how to segment the movie into utterances, for purposes of coding
in SignStream. A single SignStream utterance may contain a transcription of the entire movie
file or a transcription of just a portion of the movie file. The performance of the program may
degrade somewhat if utterances encompass large movie segments. Note that utterances may
point to overlapping segments from the same movie file, allowing long stretches of discourse
to be subdivided into overlapping segments.

Let’s finish defining our first utterance. We need to specify the portion of the movie file that
will be coded in this utterance. Basically, we need to specify where the clip for this utterance
begins and ends. Let’s set up this utterance so that it encodes the first sentence contained in
the movie. Perform the following actions:

• Make sure you are in utterance mode. Use the Utterance/Datum popup menu in the
gloss window toolbars (see Figure 6), if necessary, to switch to utterance mode.

• Using the media controls, position the movie to the first frame (the frame number in
the video window reads 0).

• Click the left “Set” button. This sets the start frame of the utterance to be frame 0. The
number 0 appears in the box next to this Set button.

• Position the movie at the desired end frame (somewhere around frame 1900, where
there is no movement).

• Click the right “Set” button. This sets the end frame of the utterance to be the frame
shown in the video window. The frame number appears in the box next to the Set
button. You can now use the buttons in the gloss toolbar (Play Clip, Go to Start, Go to
End, etc.) to manipulate the utterance. Your gloss window should resemble the picture
on the next page.



SignStream User’s Guide 20 Creating a database

Figure 8: Establishing start and end frames for an utterance

Saving your database
At this point, you might want to save your database. Select Save Database or Save Database As 
from the File menu. The program saves not only your data, but also information about which
windows are open and about their position. When you open a database, the program opens 
those windows that were open when the database was last  saved. This allows you to start 
working right where you left off.  For now, leave both windows for utterance 1 open, to continue.

Defining a second utterance
Let’s create a second utterance. Select New Utterance from the Utterance menu. The program
first asks you to identify the primary participant for this utterance. Participants are discussed
in more detail in Chapter 4: Working with multiple participants. For now, simply select the
default “Participant1,” then click OK.

The program creates a new utterance: number 2 (notice that this new utterance is added to the
list of utterances in the index window). You are presented with a new, empty, gloss window. 
When a new gloss window opens, new windows automatically open for the media files
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that were being displayed for the utterance whose window was active (frontmost) at the time
the new utterance was created (if there was one). Further, the program automatically positions 
the media at the end frame of the prior utterance.  So, if the end frame for the (previously active) 
utterance 1 was 11900, the new video window for utterance 2 would display frame 11900.

Let’s set up utterance 2 so that it points to the second clip in this movie file. The program has
already positioned the movie at the correct starting place for us, so we can simply use the left
Set button to set the start frame of the utterance. Now set the end frame of the utterance by
positioning the movie somewhere around frame number 6100 and clicking the right Set
button.

After you have established the start and end points of the utterance, use the Play Clip button
to play the utterance. Notice that there is quite a bit of “dead” time at the beginning. You can
adjust the start frame of the utterance to exclude a portion of this dead time. To do this,
position the movie at the desired start frame and then click the left Set button again
(alternatively, we could repeatedly hit the “+” button to increment the start frame number).
Set the start frame to be approximately frame number 3600. Now when you play the
utterance’s clip, you don’t have to watch so much dead time.

At this point, you should save your database file. Note that the program remembers which
windows are open, and it will open those same windows when you next open the database.
You may want to close some windows before saving your database file.

Defining a third utterance
This section shows you how to set up an utterance to point to a different movie file. If you
aren’t interested in this at the moment, you may skip this part, as the third utterance that is
created in this section will not be referred to again.

As before, create a new utterance by selecting New Utterance from the Utterance menu. Select
“Participant1” as the participant for this utterance. The program creates utterance number 3,
presenting you with a new video window and a new gloss window. The video window
displays the same movie file that we have been using, and it positions the movie at the same
frame as the end frame of the previously active utterance. (If utterance 2 had been previously
active, the movie would be positioned at the end frame of that utterance: frame 6100
according to the preceding instructions. If the previously active utterance was utterance 1,
then the movie would be positioned at frame 1900.)
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For purposes of demonstration, let’s assume that we want to code a segment that is contained
in a different movie file.

In fact, a single SignStream database may point to several different movie files. Once the
database author has established which utterances point to which files, the program will be able
to open the correct segment associated with a particular utterance automatically (as long as the
files are not moved); a browser of the database may remain unaware of the specific file
location of any particular segment.

Let’s set up this utterance so that it points to the first clip in the second movie file that is
provided with the SignStream distribution. Select Media Controller in the Utterance menu to
open the media controller. Next, click the Select button in row 1 of the video section, and use 
the open dialog box to locate set-a02.mov; this will be the movie file for this utterance. Specify
the start and end frames for the utterance in the same manner as you have for prior utterances.

Notice that there is some dead time at the beginning of this movie file. To exclude this dead
time, don’t set the start frame to frame 0. Instead, try setting the start frame somewhere
around 1500. Similarly, set the end frame to approximately 3800. Use the Play Clip button to
view the utterance that you have defined. You should now save your database file.

Where to go from here
Congratulations! You have created a SignStream database containing several utterances,
perhaps pointing to different movie files. The next chapter will show you how to transcribe
portions of those utterances.



Chapter 3: Coding utterances

In this chapter, we will code the second utterance of the database that you created in the
previous chapter. To begin, open your database and open utterance 2 (you might want to close
any other open windows, such as the index window and windows associated with other
utterances).

Note that, while knowledge of American Sign Language (ASL) will be of benefit as we
proceed, such knowledge is not required. For the benefit of those who are not familiar with
ASL, specific start and end frame numbers are provided to facilitate coding portions of the
utterance. The utterance that we will be coding in this chapter corresponds to utterance 2 in
the sample database provided with the SignStream distribution, so that sample database can
serve as a basis of comparison, if needed.

Utterance 2 contains a yes/no question, corresponding to the English “Is John buying a
house?” In what follows, we will first transcribe the manual component of the signing, and
then we will transcribe one of the non-manual items (namely, the eye brow positioning).
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Coding in the main gloss field (including coding of holds)
Manual material is coded in the main gloss and non-dominant hand gloss fields. Only the
former field will be used here; however, coding in the non-dominant field is identical.

To begin coding in the main gloss field, click inside the box next to the “main gloss” field
label. You should see a blinking text caret. Type the words that correspond to the manual signs
in this utterance: JOHN BUY HOUSE. Your gloss window should look something like the
following picture.

Figure 9: Entering text in the main gloss field

The next step is to specify the start and end points for each of the gloss items. To specify the
start and end frames for a single gloss, perform the following actions.
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• Select the item that you want to edit, by double-clicking on the word or by dragging the
mouse over the text that you want to code as a single gloss unit. When an item is
selected, the Set buttons become active. Double-click on JOHN. Your gloss window
should look like the following:

Figure 10: Selecting JOHN in the main gloss field
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• Position the movie at the starting frame for the sign JOHN, approximately frame 4025.
Set the start of the sign to this frame by clicking the left Set button. Your gloss window
should resemble the window shown below.

Figure 11: Setting the start frame for JOHN

Notice that the end frame is automatically set to be the same as the start frame; in this
way, the program ensures that the temporal information for a gloss object is fully
specified. Both the start frame number and the end frame number appear in the boxes
next to the set buttons. The gloss JOHN is now underlined, indicating that temporal
information has been specified for it, and it is preceded by a thick dot, which indicates
that the object is only a single frame in duration (its start and end frame are the same).
Notice also that the +/– buttons and the Go To Start and Go To End buttons are now
active (as is the Play Clip button; however, selecting Play Clip at this point will only
play the single frame that is associated with this datum).
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• Now set the end frame for JOHN by positioning the movie at frame 4200. Use the Set
button on the right to set the end frame of JOHN to this frame.

Figure 12: Setting the end frame for JOHN

That’s it. You have just finished transcribing the sign JOHN. Now you can, for example, play
the clip for this sign, go to the beginning of the sign, or go to the end of the sign.
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In the same manner, set the start and end points for the gloss BUY. The relevant frame
numbers are shown in the next picture.

Figure 13: Setting the start and end frames for BUY

Now let’s code the sign HOUSE. Something interesting happens with this sign in this
example. If you step through the movie (the portion that follows BUY), you will see that the
sign HOUSE is articulated by first touching the fingertips together, and then moving the
hands downward along a particular path. The hands are held at the end of this movement.
This holding is a significant characteristic of question constructions, such as the one we are
coding: in general, the final sign of a question is held. In other contexts, the sign HOUSE may
be articulated without this hold.
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SignStream allows us to code both the formational portion of the sign as well as the hold. In
order to do this, we need to enter a special character to represent the hold: the > character is
used for this purpose. Enter this character as a separate “word” in the main gloss field
(position the text caret at the end of HOUSE and type a space followed by a >). Your gloss
window should now look like the following picture.

Figure 14: Entering a hold character

Now, we will first specify the beginning and end of the articulation of HOUSE, then we will
specify the     end     (only) of the hold. The program knows that a hold begins immediately after
the articulation of the prior sign, so there is no need to specify the beginning of the hold. (If
you set the start frame of the hold, then the > character will be treated by the program as a
separate gloss item.)
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To define the start and end points of HOUSE, first select the gloss HOUSE, and then set the
start and end frames just as you have with other gloss items. The picture below shows the
start and end frames of HOUSE, as they are coded in the sample database.

Figure 15: Setting the start and end frames for HOUSE
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Now select the hold character (double-click or drag the mouse over it), so that its end point
can be specified. The sign HOUSE is held until frame 5325. Set the end point of the hold
character to be this frame. When you specify the end point, the program automatically inserts
a vertical bar, and attaches the hold character to the previous sign, as shown in Figure 16. (The
vertical bar is intended to indicate that the hold abuts the sign to which it is attached.)

Figure 16: Setting the end frame for the hold

A brief word about holds is in order. Holds can be manipulated separately from the sign to
which they are attached: they can be deleted, edited, and manipulated in other ways (e.g., you
can go to the end point of the hold). However, the program also recognizes that a hold is
associated with the previous gloss. For example, if the previous gloss is deleted, the hold is
deleted as well.

The current implementation of the program limits the utility of holds in certain ways. For
example, it is not possible to select multiple items in the gloss field simultaneously; therefore,
you cannot select both the gloss (HOUSE) and the hold. Thus, you cannot use the Play Clip
button to play that combination of items. Additionally, using Play Clip on the hold itself will
only position the movie at the end of the hold (the program does not currently play the clip
between the beginning and the end of the hold).

We have now finished coding the main gloss data for this utterance.
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Coding a non-manual item
This section demonstrates how to code data in a non-manual field. In particular, we will code
the raised eye brows that occur in this utterance.

In order to code data in any particular non-manual field, we must first add the field to our
gloss display. Click on the Show Field button, and select “eye brows” from the list of fields that
appears. Your gloss window should now contain an empty “eye brows” field.

Figure 17: Displaying a non-manual field

There are two ways to enter data into non-manual fields (fields that occur above the gloss
fields). These are demonstrated in turn.

Entering a non-manual item by drawing a line

The first method for entering a non-manual item involves drawing a line within the
relevant field. The line that is drawn may initially represent an estimate of the extent of the
non-manual event; it is, of course, possible to adjust the line later.

To draw the line, first click once in the eye brow field (so that the entire field is no longer
highlighted). This tells the program that you want to enter data into this field.
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Next, click and hold the mouse button at approximately the position where you think the
raised eye brows begin. (As an aid, you might want to first position the movie at that frame
(frame 3875), and then use the media alignment indicator as a guide. If you do this, you can
click-and-hold the mouse button right at the indicator line.)

Now, while still holding down the mouse button, stretch the line rightward to the position 
where you think the raised eye brows end.  Notice that, as you stretch or shrink the line, the 
movie advances or rewinds so that it continuously shows you the frame that corresponds 
to the position of the mouse. When the movie displays the frame where you think the raised 
eye brows end (frame 5350), release the mouse.

When you release the mouse, a window with a list of values appears, asking you to select a
value for this new non-manual item. You can pick from one of the predefined values, or you
can define a new value. Choose “raised” from the value list. Once you have selected the value
and clicked OK, a labeled line appears in the field, as shown in the following picture.

Figure 18: Entering a non-manual

The new raised eye brows datum is automatically selected by the program, as indicated by the
“handles” at each end of the line. You can adjust the start and end frames of the datum by
clicking and dragging either of the handles. Alternatively, you can use the Set or +/– buttons.
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Note that, when entering a non-manual item by drawing a line, you can start at any point
within the field’s box and drag in either horizontal direction. The start frame corresponds to
the left point of the line and the end frame corresponds to the right point of the line,
regardless of where you begin the click and drag operation or where you eventually release
the mouse.

Entering a non-manual item via the Set buttons

A second method for entering non-manual data involves using the Set buttons. Let’s enter
the same “raised eye brows” datum using this alternative method. First delete the line you
had just drawn by pressing the delete key (the line should still be selected; if not, select it so
that its selection handles are visible). After you delete the non-manual item, the eye brows
field should still be active for data entry (the field label at the left should be highlighted).

One way to use the set buttons to enter a new non-manual item is to position the movie at
the appropriate start frame and then use the left Set button to establish a new non-manual
item beginning at the point. So, position the movie at frame 3875 and click the left Set button.
After you click the Set button, you will be prompted to choose a value for the new non-
manual item; select “raised” from the list of values. The program then creates a new non-
manual item with the specified value and start frame; the end frame is automatically set to be
the last possible frame (either the frame immediately before the start frame of the following
non-manual item in this same field, if there is one, or the frame immediately before the end
frame of the utterance). Thus, the program initially establishes the non-manual item with its
maximum possible extent. Most likely, you will need to adjust the end frame of the datum. To
do so, position the movie at frame 5350 and click the right Set button. (Alternatively, you
could have dragged the end frame handle of the line, or used the +/– buttons.)

An alternative to the above is to use the right Set button to establish a new non-manual item.
Delete the non-manual datum you just created; we will create it again, but using the right Set
button. Since this button sets the end frame of an item, you must first position the movie at
the frame that corresponds to the end of the non-manual event you wish to enter (frame
5350). Click the right Set button and then select a value. Analogous to what happens with the
left Set button, the program automatically establishes a new non-manual with the maximum
possible extent, although, since you specified the end, and not the start, of the non-manual
item, the program fills in the start frame to be the earliest possible frame (either the frame that
immediately follows the end frame of the previous non-manual in the field, if there is one, or
the frame that immediately follows the start frame of the utterance). Adjust the start frame to
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be frame 3875 by dragging the handle at the left end of the line, by using the Set buttons, or by
using the +/– buttons.

Using the notes window
Comments about an utterance can be entered in the notes window. Each utterance has its
own separate set of notes. You can access the notes by clicking on the Notes button in the gloss
window or by selecting Open Notes from the Utterance menu. Text within the notes is
searchable.

Where to go from here
This concludes the introduction to coding. If you are interested in learning about how to work
with multiple participants, you should proceed to the next chapter. Information about how to
tailor SignStream to code your own particular type of data is contained in Chapter 5:
Modifying field and field value definitions. To learn about the search capability, proceed to
Chapter 6: Searching. The script facility is described in Chapter 7: Scripts.



Chapter 4: Working with multiple participants

All data in SignStream databases are associated with particular participants: those people in
the movie who articulated the data. SignStream allows you to set up different participants.
For each participant, you can specify certain kinds of background information. Additionally,
within any single utterance, you can code data for different participants, assuming your
movie depicts all the utterance’s participants (it is currently not possible to link an utterance
to multiple synchronized movie files, each portraying a different participant). All information
from each participant is time-aligned, so that the display reflects the simultaneity of coded
events. Although the sample database contains only a single participant, the database in the
“SignStream extras” folder on the SignStream CD-ROM (also available over the WWW)
contains utterances incorporating multiple signers conversing with each other.

Figure 19 on the next page illustrates an utterance containing data associated with two distinct
participants: Participant1 and Participant2 (note that this particular transcription was created
for illustrative purposes only). The participant identifier menu, in the upper left corner of the
participant pane, identifies the participant that is being viewed in the pane. If you click the
participant identifier menu, a list of all participants in the database appears, and you can select
a different participant to view in the pane.

In the participant identifier menu (and in other participant listings as well), the primary
participant’s name is always displayed in bold. An asterisk next to a participant name indicates
that the participant is active in the utterance. Any participant that is being viewed in the gloss
window is considered to be active in that utterance. There may also be hidden participants for
whom data has been coded; these are also active. However, there may be other participants in
the database that are not active in the utterance. This distinction is important for the search
mechanism, as searches are conducted only over the active participants in an utterance.

In the utterance illustrated in Figure 19, Participant1, the primary participant, is posing a
question roughly equivalent to the English “As for John, where do you see him?” Participant2
articulates a rapid head nod in the middle of Participant1’s question (specifically, toward the
end of the topic constituent).

Note that the horizontal line that divides the participant panes is draggable, allowing you to
allocate different proportions of the window space to the different participants.
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Figure 19: Illustration of multiple participants

Creating and editing participants
Participants can be created, edited, and deleted through the participants editor, which is
opened by selecting Participants Editor from the View menu or by clicking the Edit Participant
button in the gloss window. The participants editor allows you to specify certain background
information about the person(s) appearing in the movie, such as name, age, native language,
information about parents, etc..
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Note that some words and characters are reserved for searching and cannot be used to name a
participant. See discussion in Appendix B: Reserved words and characters.

Caution    : When you delete a participant, all data that has been coded for that participant in all
utterances in the database are deleted as well. This operation cannot be undone. There must
always be at least one participant in a database.

Coding data for a participant
As previously mentioned, each datum in an utterance is associated with a particular participant.
For each utterance, one participant must be designated as     primary    : the primary participant is
intended to correspond to the one whose conversational turn is depicted in the movie (thus,
when the conversational turn ends and another participant starts up a turn, a new utterance
should be created). The primary participant is indicated by a filled Primary participant button,
located at the right top of the participant pane.

The gloss window can be divided into one or more participant panes. Note that a minimal
amount of screen space is required for display of a participant pane. If your gloss window is
too small, the program may not be able to display an additional participant pane simul-
taneously. You may need to make the gloss window larger in order to display additional
participants.

A participant pane contains the data coded for the participant designated in the participant
identifier popup menu at the top left of the pane. Selecting from this popup menu allows you
to choose a different participant to display in this pane (it does not allow you to associate the
data displayed in the pane with a different participant). You can only select from participants
that are not already being displayed in the gloss window.

Caution    : You should be careful to specify the correct participant prior to the coding of data. If
you mistakenly code data for the wrong participant, there is no way to move those data to a
different participant. This is because in the current implementation it is not possible to copy
and paste data objects (from one participant to another). It is, however, possible to rename a
participant after data have been coded. So Participant1 could be assigned a different name at a
later time; all data previously associated with Participant1 in all utterances in the database will
then be associated with the new participant name.



Chapter 5: Modifying field and field value definitions

For maximum flexibility in the coding of a variety of types of data, SignStream allows the user
to define new fields and new field values and to modify existing fields and field values. Fields
and field values are defined and changed through the field specifications editor, accessed via
Field Specifications Editor under the View menu. The field specifications editor is illustrated
in Figure 20.

Figure 20: The field specifications editor
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SignStream provides an initial set of fields to work with (these are described in Appendix A:
Fields and values). You can edit these fields or define new ones. There are three types of fields:
non-manual fields, gloss fields, and text fields. Non-manual fields are displayed as labeled
lines, whose endpoints are aligned to frames in the video. Gloss fields allow you to align
sequences of text to the video. Finally, text fields contain free text that is not aligned to the
video. The non-manual, gloss, and text fields are displayed in three different regions in the
field specifications editor (as well as in an utterance’s gloss window).

To edit a field’s specification, select a field from the list of field names and then click the Edit
button at the bottom of the window. A new window appears, allowing you to change various
properties of the field. The contents of this window differs depending on whether you have
chosen to edit a non-manual, gloss, or text field, as illustrated in the following three pictures.

Figure 21: Editing a non-manual field specification
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Figure 22: Editing a gloss field specification

Figure 23: Editing a text field specification

For any kind of field, you can:

• change the     name     and    label    of the field (the name is used in menus, while the label,
often shorter than the name, is used in gloss windows, to the left of the field in a
participant pane). Note that certain words and characters are reserved for searching and
cannot be used as field names or labels. See Appendix B: Reserved words and
characters.

• change the color that is used to display the field (via the Field Color button).
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For a non-manual field, you can additionally:

• specify a prefix to be added to every field value. (For example, the “role shift” field
employs a prefix of “rs:”, so that values may be defined as “JOHN” but they appear in
the transcription as “rs:JOHN”.)

• edit a value: select the value from the list of values, and then edit its name and label as
desired (the label is the text that gets displayed above the line in the gloss window;
generally, it is the same as or an abbreviated form of the name). Changes to a value’s
name, label, and/or color will be propagated throughout the database.

• create a new value: select New Value, then specify the name and label.

• delete a value: select the value name and label pair to be deleted, then click the Delete
Value button. Note that when you delete a value, all instances of that value that have
been coded in your database are deleted as well.

To create a new field, click on one of the buttons on the right in the field specifications editor
window: New non-manual, New gloss, or New text. You will then see one of the three field
type editing windows, depending on the kind of field you have chosen to create. You can now
specify the characteristics for your new field.

After you have finished making changes, click the Done button to return to the main field
specifications editor window. You can make more changes to other fields, or click Done to
finalize your modifications.

As a shortcut, you can edit a field’s specifications directly by double-clicking on its field label,
located at the left edge of the field within a gloss window. In this case, the appropriate editor
window appears directly to allow you to edit the field; the main field specifications editor
window (Figure 20) is not opened.

Note that the defined set of fields and values is a characteristic of a database file. One database
may utilize a different set of fields and values from another. There is currently no way to
export the field specifications of one database to be used in creating another. As an alternative
workaround, you can duplicate a database file and then delete all of the utterances in the new
copy. This will preserve the field specifications and data of the original database, while giving
you a new database file with matching field specifications.



Chapter 6: Searching

With SignStream, you can search a database for all utterances that match a certain criterion, as
specified in a search query. Searches can be conducted in stages, allowing you to refine your
search progressively. A search, including its queries and results, can be saved to a file, so that
you keep a record of your search for recall during a future session.

This chapter introduces the search facility by first leading you through the construction and
execution of a multi-stage search. Next, the chapter focuses on the construction of more
complex queries by documenting the available operators and discussing query manipulation
in more detail. The chapter concludes with discussion of the manipulation of search files.

The search window
To begin a search, select New Search from the File menu. A new, untitled search window
appears, such as the one in Figure 24.

search tools

search domain
information area

search stage

Figure 24: The search window
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The search window is divided into three main areas. At the top is the search toolbar, which
contains a number of buttons for performing various operations relevant to composing a
search query. Under the toolbar is an area for displaying information about the search
domain, that is, the name of the database to search over. The rest of the window contains one
or more stages of search activity. Each search stage contains a search query and a set of results.
Buttons within each stage allow you to add a stage, delete a stage, and execute a search.

Conducting a single-stage search
The best way to become familiar with the various components of the search window and the
way that searching works is to go through the process of conducting a search. Let’s imagine
that we want to search for all wh-questions in the sample database. Before we can begin
constructing a search query, we must first specify the domain (the database) over which we
want to search. Because each database can have a different set of fields and values, a query
cannot be composed properly until we know what fields and values are defined in the search
domain.

We can specify the search domain in one of two ways: by clicking on the Domain button in
the search toolbar or clicking in the search domain information area. In either case, a dialog
box appears, allowing us to specify the desired database file. Try that now: click in the search
domain information area, and then locate and select the sample database. The name of the
sample database should now appear in the search domain area.

Once the domain has been specified, the Datum and Participant buttons become active. (These
buttons are not available until after the search domain has been specified because the program
cannot know what fields, field values, and participants are relevant, since such information
may vary from one database to the next.) Click on the Datum button; a floating palette appears
listing all the fields contained in the search domain, as shown in Figure 25 on the next page.
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Figure 25: The Datum palette

If the database that is serving as the search domain is actually open and has been modified, the
program will not allow you to open the Datum palette. You have to first save or close the
database file. (If you modify the search domain database after the Datum palette has been
opened, the program will close the palette and you will not be able to open it again until the
database is saved or closed.)

In addition to the Datum palette, there are two other search palettes: the Participant palette
and the Operator palette, illustrated in Figure 26 on the next page (the Participant palette in
the figure is not based on the sample database, which only contains a single participant, but on
the “DSP 3signers DB” that is distributed with the SignStream program). All three of the
search palettes are opened by clicking on the associated buttons in the search window: the
Datum, Participant, and Operator buttons. Click on the Participant and Operator buttons to
open these two palettes; now, all three palettes should be visible on your screen. You can
move each of the palettes to a more convenient location, so that they do not obscure the
search window. The Participant palette is like the Datum palette in that it cannot be open if
the search domain database is in an open, modified state.
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Figure 26: The Participant and Operator palettes

These palettes behave similarly to floating palette windows that you may have encountered
in other programs. The search palettes are visible only when the active window is a search
window. If you click on another kind of SignStream window (e.g., a video or gloss window) or
if you switch to another program, the search palettes will be hidden from view. They will
reappear when a search window is activated. If you close a palette by clicking on its close box
in the upper left corner, you can open it again by clicking on the appropriate button.

A search query is composed by selecting various pieces from the search palettes and inserting
the selections into the active query area (queries cannot be composed by typing directly in the
query area). For example, to search for a specific field/value combination, you select that
combination in the Datum palette and insert it into the active query area. The Datum palette
is organized so that fields are displayed on the left and values on the right. As you select a
field from the list on the left, any predefined values for that field appear in the box on the
right. You can then select one of these predefined values or you can type in a value. In the
latter case, you can choose to restrict the search to match the typed value exactly (“exact word”)
and/or to match the case of the value (“match case”).

Notice that field values are listed in the Datum palette via their full names (not their shorter
labels). When the program conducts a search, it attempts to match both the full names and
labels of field values. For example, if you choose to search for “Proper Noun” in the POS (part
of speech) field by selecting that field and value from the two lists, you will match instances
that appear in the gloss window as “PN”, because “PN” is the short label for the field value
“Proper Noun”. More significantly, if you type in the value “PN” and choose to search for that
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value in the POS field (or in any field, as described immediately below), you will match
instances of “Proper Noun/PN”.

The Datum palette also includes several radio buttons that allow you to specify other options.

•  any field: Search over any field in the list of fields.

•  any gloss field: Search in any gloss-type field.

•  any non-manual field: Search in any non-manual field.

•  notes: Search in the notes of the utterances.

You can choose to restrict your search to a specific participant and/or participant role, by
making the relevant selections in the Participant palette and inserting that information into
the query. For example, from the palette shown earlier in Figure 26, you could choose to
restrict your search to participant “A (left)” in the primary role.

Now that we are familiar with the search palettes, let’s actually do a search. Our goal is to
search the sample database for instances where primary participant “Ben” is associated with
“wh” in the wh-question field. First, we will insert the participant reference. Select “Ben” and
“primary role” in the Participant palette (as shown in Figure 27 on the next page) and click
Insert. (If you make a mistake, delete the text in the query window–by selecting it and using
the delete key–and then (re)select the correct items and click Insert again.) The program
inserts text representing your selection into the query window, as shown in Figure 27 on the
next page.
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Figure 27: Searching in primary participant “Ben”

Notice that the blinking text caret (the black vertical line in the figure) is positioned between
the brackets. This is where we will insert our field/value reference from the Datum palette.
So, select the “wh-question” field in the left box of the Datum palette, scrolling the list of fields
if necessary. When you select this field, a list of values appears in the box on the right. Select
“wh” from that list. With both the field and the value selected, click the insert button. Your
query should now look like that shown in Figure 28 on the next page.
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Figure 28: Searching for “wh” in the “wh question” field in primary participant “Ben”
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The query text appears as:

primary PARTICIPANT Ben[wh question[wh]]

The meaning of this query is as follows: search in primary participant Ben for a “wh question”
field containing the value “wh”. In other words, the syntax of the query represents an
embedding of information that reflects the way SignStream data are organized, in terms of
participants, fields (within participants), and values (within fields).

In some instances, it is not necessary to insert the participant part of the query manually. In
particular, if we don’t care about the participant, instead of manually inserting “any
participant” in “any role,” we can simply go ahead and insert from the Datum palette; the
program will automatically add the generic participant information.

Once you have finished constructing your search query, execute the search by clicking on the
“Search” button at the top right of this search stage area. When the program has finished, you
will see a summary of the results of the search. In this case, “Result: unexecuted” changes to
“Result: matched 5 out of 10 items in the domain”. To see the list of utterances that were
matched, expand the results display by clicking on the triangle to the left of “Result.” Your
search window should now look like the one in Figure 29 on the next page. If you double-click
on an item in the results list, the program will open that utterance.

Note that when the program searches over utterances in the database for matches to a search
query, it only searches in those participants that are active in an utterance. In many cases, the
search results would be the same regardless of whether the program were to search only in
active participants or in all participants. However, the distinction is relevant in those cases
where the search involves looking for the absence of some datum (e.g., searching for “none”
in some field). Since only active participants are searched, only an utterance containing an
active participant that lacks the datum will be matched; inactive participants (which
necessarily contain no data) will not trigger spurious matches.



SignStream User’s Guide 51 Searching

Figure 29: Search results

Conducting a multi-stage search
Now that we have located all the utterances in our database with “wh” marking in the “wh-
question” field, let’s further refine our search to isolate those wh-questions that contain the
gloss “WHICH”. We can do this by conducting a multi-stage search, which allows us to search
further over the results of a previous search.

Within any search window, you can create a number of search stages. There is always one
stage that is “active”; the active search stage is the one whose query area or result area contains
the selected text or flashing text caret. Each search stage contains three buttons at the top right.

•  New Stage: Click this button to add a new stage immediately following this one.

•  Delete Stage: Click this button to delete this stage. Note that this button is only active if
there is more than one search stage, as there always must be at least one search stage.
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•  Search: Click this button to execute the search for this stage; option-click to execute the
search for this stage and all subsequent stages.

Click on the New Stage button to create a new search stage below the current one. Resize the
window so that you can see both search stages. Notice that the insertion point is now located
in the lower query area. Using the Datum palette, insert “PARTICIPANT *[main gloss[WHICH]]”
into the new stage’s query area by selecting the “main gloss” field and typing “WHICH” in the
value box, as shown in Figure 30, then clicking Insert.

Figure 30: Inserting “main gloss[WHICH]” via the Datum palette

Execute this stage of the search by clicking on the “Search” button in the lower search stage.
After you expand the results, your window should resemble that shown in Figure 31 on the
next page. Notice that the result summary states that only 1 out of 5 items was matched; that
is, only the five utterances that were found in the previous stage were searched this time, not
the whole database.
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Figure 31: Results of multi-stage search

There are certain operations that can be performed on a stage that will invalidate the search
results of that stage as well as any subsequent (lower) stage (changes never affect a previous
stage). These include adding a new stage, deleting a stage, and changing the stage’s query.
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When one of these operations is performed, the results of that stage and all subsequent stages
are deleted and those stages revert to the “unexecuted” state.

Formulating complex queries
The examples thus far have involved simple search queries, consisting of a single datum
reference, that is, a single field[value] combination. More complex queries can be constructed
by using operators to combine query pieces. The available operators are contained in the
Operator palette (shown earlier in Figure 26). This section first describes the available
operators. Next, it demonstrates how to assemble complex queries. Then, it discusses the
evaluation of queries and issues surrounding the precedence relations of the various
operators. Finally, some sample queries are presented.

Search operators

SignStream provides two kinds of operators: Boolean operators  (AND, OR, and NOT) and
temporal operators (WITH, BEFORE, AFTER, STARTFRAME, ENDFRAME, FRAMED, and
UNFRAMED). These two types of operators accept different arguments, or operands, and
return different kinds of values.

The Boolean operators are standard logical operators; they evaluate to either true or false.
Operands of a Boolean operator can be either simple datum references or complex expressions
that return Boolean values (true or false).

AND: returns true if both operands evaluate to true; otherwise false.
OR: returns true if either (or both) of the operands evaluates to true; otherwise false.
NOT: returns true if the operand evaluates to false; otherwise false.

The temporal operators perform computations related to the temporal properties of their
operands. These operators thus require temporal operands: simple datum references or other
expressions that return temporal values (namely, expressions involving the STARTFRAME
and ENDFRAME operators). In particular, a temporal operator cannot have an operand that
returns a Boolean value; AND, OR, and NOT, for example, may not be used to construct
operands of a temporal operator. Also, a Notes reference cannot serve as an argument to a
temporal operator, as notes data are not temporal.

The WITH, BEFORE, and AFTER temporal operators take 2 arguments and return a Boolean
value. STARTFRAME and ENDFRAME each take a single argument and return temporal
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information about that argument. FRAMED and UNFRAMED also take a single argument,
but they return a Boolean value.

WITH: returns true if the operands overlap temporally, that is, if they share one or
more video frames; otherwise false.

BEFORE: returns true if the end frame of the first operand is less than the start frame of
the second operand; otherwise false.

AFTER: returns true if the start frame of the first operand is greater than the end frame
of the second operand; otherwise false.

STARTFRAME: returns the start frame of its operand.
ENDFRAME: returns the end frame of its operand.

FRAMED: returns true if its operand is found to be temporally aligned (i.e., has start
and end frames); otherwise false.

UNFRAMED: returns true if its operand is found and is not temporally aligned (i.e.,
does not have start and end frames); otherwise false.

Note that datum references have a dual status in that they can serve as both temporal
operands and Boolean operands. They can be treated either in terms of true/false (existence)
or in terms of their temporal information.

Assembling complex queries

Complex queries are constructed by inserting operators and operand expressions from the
various palettes. As an example, let’s construct a query to search for utterances containing
either wh-question or yes/no-question marking.

Start a new search and establish the sample database as the search domain (as described earlier
in this chapter). Construct the first part of the query by selecting the field “wh question” and
value “wh” from the Datum palette and clicking Insert. Your query should now look like that
shown below (where ∆ marks the insertion point—the blinking text caret).

PARTICIPANT *[wh question[wh] ∆]

Notice that the insertion point is positioned after the datum reference, but still within the
scope of the participant reference. The text caret is positioned at the correct place for us to
continue inserting pieces of our query.
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At this point, we can either insert the OR operator, or insert the next datum reference. Let’s
insert the OR operator by selecting it from the Operator palette. The text caret is positioned
immediately after the OR operator.

PARTICIPANT *[wh question[wh]  OR∆]

Now insert our second datum reference by selecting “yes/no question” “y/n” from the Datum
palette and then clicking Insert. Your query should now look like:

PARTICIPANT *[wh question[wh]  OR  yes/no question[y/n] ∆]

You can now execute this query to find the set of utterances that match it (you should match 6
out of the 10 utterances in the search domain).

Let’s modify the query so that it will also match negative utterances as well. To do this, we
will need to insert another OR operator, as well as the relevant datum reference. So, position
the text caret immediately after the “yes/no” reference, inside the outermost bracket (if it is
not already there). Insert another OR operator at this position. Now insert a “negative” “neg”
datum reference, so that your query looks like the following:

PARTICIPANT *[wh question[wh]  OR  yes/no question[y/n]  OR  negative[neg] ∆]

When you execute this query, you should match 9 of the 10 utterances in the search domain.

Evaluation of queries and precedence of operators

When queries combine several operators, there is a certain order in which elements are
evaluated. Generally, elements are evaluated from left to right. However, certain operators
take precedence over others. The precedence of operators is as follows:

{ STARTFRAME, ENDFRAME, FRAMED, UNFRAMED }
 > NOT > { BEFORE, AFTER } > AND > WITH > OR

Operators contained in { } have the same precedence. Consider the following example.

1. PARTICIPANT *[NOT  wh question[wh]  OR  yes/no question[y/n]]

Here, the NOT operator is evaluated first because it has precedence over OR. NOT is applied
only to the first datum reference, as indicated by the grouping (parentheses) shown in 2 below.
Thus, this query will match all utterances that either lack “wh” wh question marking or
contain “y/n” yes/no question marking.
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2. PARTICIPANT *[(NOT  wh question[wh])   OR  yes/no question[y/n]]

Of course, you can always use the group function to place parentheses around items that you
would like grouped together, either to override the order in which expressions are evaluated,
or to clarify what is intended. If you wanted NOT in a query such as 1 or 2 above to apply to
the OR expression, you could group the elements associated with the OR operator by selecting
the text “wh question[wh]  OR  yes/no question[y/n]” and clicking the Group button. This
would result in the query shown in 3 below.

3. PARTICIPANT *[NOT  (wh question[wh]  OR  yes/no question[y/n]) ]

The meaning of 3 differs significantly from that of 2. Query 3 searches for utterances that are
neither wh-questions nor yes/no questions. Query 2 searches for utterances that are either
yes/no questions or not wh-questions. If you execute these two queries, you will get different
results: query 2 matches 5 utterances in the sample database, while query 3 matches 4
utterances.

Sample queries

NOTES[verify]
This query searches for any utterances containing the substring “verify” within the utterance’s
Notes. Notice that there is no participant reference associated with this query, as Notes data
are associated with utterances, not with specific participants.

PARTICIPANT *[main gloss[]]
This query searches for utterances containing any active participant with nothing coded in the
main gloss field.

PARTICIPANT *[eye brows[raised  OR  lowered]]
This query searches for utterances containing any participant with either raised or lowered eye
brows.

PARTICIPANT *[eye gaze[*]  WITH  main gloss[IX]]
This query searches for utterances containing any value of eye gaze that temporally overlaps
with IX in the main gloss field, within any participant.
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PARTICIPANT *[eye gaze[*]]  WITH  PARTICIPANT *[main gloss[IX]]
This query searches for utterances containing any value of eye gaze, within any participant,
that temporally overlaps with IX in the main gloss field, within any participant. Note that the
two participants may be different; in this respect, this query differs from the previous one.

primary PARTICIPANT *[ eye brows[raised]  BEFORE  GLOSS-FIELD[*]]
This query searches for utterances containing a primary participant in which raised eye brows
occur (both start and end) before some gloss item. Note that the raised eye brows need not
occur before every gloss item.

primary PARTICIPANT *[STARTFRAME  eye brows[raised]  BEFORE GLOSS-FIELD[*]]
This query is similar to the previous one, except only the start of the raised eye brows need be
before some gloss item. Notice that because the STARTFRAME operator has precedence over
BEFORE, it is applied first, and its operand is “eye brows[raised]”.

UNFRAMED  PARTICIPANT *[GLOSS-FIELD[*]]
This query searches for utterances that contain some text in a gloss-type field that has not been
temporally aligned.

Manipulating pieces of a query
Although queries cannot be modified by typing text directly, it is possible to make changes to a
query in a variety of ways, e.g., selecting portions of a query for replacement, deletion, or
grouping and moving the insertion point and then inserting additional material. This section
describes how components of a query can be manipulated.

As previous examples have demonstrated, queries are structured in a hierarchical fashion,
with each level delimited by brackets. At the outermost level of a query is the participant
reference (there is one exception: a notes reference does not occur within a participant
reference). Within the participant reference can be found datum references, consisting
potentially of multiple field references connected by operators. Within a datum reference is a
value reference, which, again, may consist of a number of values connected by operators. Of
course, a query can be composed of multiple participant references connected by operators.

<Participant spec> [ <datum spec> [ <value spec> ] ]

SignStream allows you to select these various informational units, such as values, datum
references, participant references, and operators, as well as multiple units for grouping
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purposes. You are only allowed to select coherent units. Thus, you cannot select only a
portion of a participant reference, nor can you select a datum reference without also selecting
its embedded value reference. When you click (and drag) within a query, the program
automatically selects a coherent unit of information. The editing operations that you can
perform depend on the kind of unit that you have selected. For example, you can only use the
Ungroup button if a complete grouping, from left parenthesis to right parenthesis, has been
selected.

In addition to constraining selection possibilities, the program also constrains the insertion of
portions of a query. Material from the various palettes can be inserted only when the
insertion point is positioned at an appropriate location. For example, when the insertion
point is located within a value reference, you cannot insert from the Participant palette (an
error message appears if you try to do so). Of course, any inserted material will replace
whatever is selected. In what follows, constraints on insertion/text replacement at the various
levels of query editing are summarized.

• Within brackets enclosing a value reference, you can insert from the Datum palette
only if the field that is selected in the palette is the same as the field that encompasses
the value reference. You can also insert an operator, because operators can appear
within brackets specifying field values (see examples). However, you cannot insert a
different field[value] combination, nor can you insert a participant reference.

• Within brackets enclosing a datum reference, you can insert from the Datum and
Operator palettes, but not from the Participant palette.

• If the insertion point is at the participant level (i.e., next to a participant reference or at
the outermost level), you can insert from any of the palettes.

Although the standard behavior is to replace whatever material is selected with the newly
inserted material, there is one instance where it is possible to replace only part of the selection.
In particular, it is possible to replace only the participant information in a selection when
inserting from the Participant palette, leaving the datum information intact. This is achieved
by holding down the option key while clicking Insert in the Participant palette. If the selection
does not contain any participant references (e.g., if the selection is an operator or a notes
reference), then the partial substitution cannot be made and an error message is displayed.
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Checking the syntax of queries
The Check button can be used to check the syntax of a query (the syntax is also checked when a
search is executed). If there is a problem with the query, an error message appears in a
moveable modal dialog window, and the program either highlights the problematic portion
of the query or moves the insertion point to the locus of the problem. In addition, the
program displays how it has grouped things by inserting gray parentheses; these parentheses
will remain displayed until the query is modified.

Some examples of incorrect queries and the error messages they generate are presented below.
In these examples, the location of the insertion point, after the query check, is indicated by ∆,
and highlighting is indicated using yellow.

PARTICIPANT *[eye brows[raised]] ∆ PARTICIPANT *[eye gaze[*]]

Message: The operand that follows the insertion point must be preceded by an operator.

The problem here is that there are multiple participant references, and the relation
between them is unspecified. They must be connected by a binary operator such as
AND, OR, or WITH.

PARTICIPANT *[negative[neg]  WITH  (head mvmt: shake[slow]  AND  eye brows[lowered])]
Message: The operator that precedes the selected operand requires an operand that has a
temporal value.

The problem here is that one of WITH’s operands is Boolean (the AND operator
returns a Boolean value). In fact, there is currently no way to formulate a query that
will search for one datum overlapping with some other set of datums, as intended by
this query. Future extensions to the search mechanism will allow this possibility.

PARTICIPANT *[negative[neg]  WITH∆]

Message: An operand needs to be placed at the query’s insertion point.

WITH is a binary operator. Here, it only has one operand.

PARTICIPANT *[]
Message: The selected participant reference does not contain a field reference.

The participant reference is missing a datum reference (either because one was never
inserted or because it was deleted).
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STARTFRAME  PARTICIPANT *[nose[*]]
Message: The query is syntactically correct but does not yield an ultimate true/false value.

Because the STARTFRAME operator, like ENDFRAME, returns a temporal value (not
a Boolean one), it can only serve as an operand to another temporal operator. The
FRAMED and UNFRAMED operators can be used to search for elements with or
without a start and end frame.

Manipulating search files
All information in a search window (domain, queries, and results) can be saved to a search
file by selecting either Save Search or Save Search As in the File menu while the window is
active. A previously saved search file can be opened either by double-clicking it from within
the Finder (which will launch the SignStream application, if necessary) or by selecting Open
Search from SignStream’s File menu and then locating the search file.

If, for some reason, the program cannot locate the search domain database file when it tries to
access it (e.g., when the Datum or Participant palettes are opened or when a search is
executed), an error message is reported. If this happens, you must re-specify the search
domain.



Chapter 7: Scripts

The script facility makes it possible to select a subset of utterances from a particular
SignStream database file to be played in sequence. It is possible to reorder utterances within a
script. Scripts can be saved so that you (or others) can view the selected utterances in the
desired sequence.

Creating a new script
Choose New Script from the File menu, and an untitled script window will open. First,  select
the database from which the utterances for the script are to be chosen. This may be done in
one of two ways: either by clicking on the Select DB button in the script toolbar or by clicking
in the Script Database information area. This will then allow you to select a SignStream
database.  That database will then be opened (if it was not already open) and the index window
will be brought to the front.

Selecting and ordering utterances
To select those utterances that are to be included in the script, hold down the option key 
and click and drag an utterance in the index window to the script window. (Utterances
must be selected and dragged one at a time, but it is possible to include a single utterance any
number of times in the script.)

Utterances will initially appear in the script window in the order in which they were selected, 
as illustrated in Figure 32. However, they can be reordered by holding down the option key  
and dragging a given utterance in the script window to the desired position in the sequence.

(It is actually not necessary to select a database file before option clicking and dragging an
utterance from an open utterance index window into the Script window. When you drag the  
first utterance into the window, that database file will automatically be selected for the script.)  
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Figure 32: Script window

To remove an utterance from the script, select that utterance (by clicking on it with the
mouse; it will then appear highlighted, like entry 3 in Figure 32) and click on the Delete Entry
button in the script toolbar.

Removing and reselecting a database file
The Remove DB button will de-link the database and remove all utterances from that script.
You can then select a new database by clicking on the Select DB button or by clicking in the
Script Database information area and reselecting a different database file. (In fact, it is not
necessary to remove the current database file before reselecting another. If you select a new
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database file, the current database file is automatically de-linked and all utterances in the script
are deleted from the script.)

Playing utterances
The green triangle in the script window marks the current entry. The triangle can be dragged
to any entry in the list.

Clicking on the Play button in the script toolbar will cause all of the entries to play in
sequence, beginning with the current entry (marked with the green triangle). As each new
utterance in the entry sequence is launched, the windows from the previous utterance are
first closed. (Any utterances that were open prior to the script being launched will remain
open.)

You can stop a script from playing by clicking on the Stop button in the script toolbar
(after first clicking once on the script window to activate the window). 

You can resume play by clicking on the Play button in the script toolbar. Play will resume 
from the beginning of that current entry.

The Forward button will open the utterance immediately following the current entry (and
that utterance itself then becomes the current entry); and the Back button does the same for
the preceding entry.

Double clicking on any entry in the list will open that utterance (which can be played using
the usual SignStream controls).

Saving and opening scripts
You can save your script by selecting the Save Script or Save Script As items from the 
File menu.  You can open an existing script by choosing Open Script from the File menu.

Exporting a script movie
It is possible to save the video sequence associated with a script as a single movie file. To do
this, choose the option Export Script Movie from under the File menu.

The exported movie file contains only a list of the movie file names and locations plus and start
and end frames for all utterances in the script window. Therefore, the exported file will be quite
small. However, to play this exported movie, all the movie files it points to must be accessible.
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Note that this export function only creates a movie file; any information coded in the original
utterances is not exported. However, it is possible to associate this new movie file with a
SignStream utterance and code it in the usual way.

The Export Script Movie command, under the current implementation, will export the
topmost video (as listed in the media controller) for each utterance. If there is an audio file but
no video file associated with the utterance, then the audio file will be exported instead.
Currently, it is not possible to export both the video and audio into a single integrated file.
However, when a video file is exported, all its tracks, including any audio track, are included
in the resulting file.

Where to go from here
This concludes this part of the user’s guide. You should now have gained working knowledge
of the SignStream program, and you can proceed to code and analyze your own data.

The next chapter documents the program’s menus and menu items. Many of these items
have not been discussed yet, so it is a good idea to look through them. The remainder of the
manual contains four appendices. The first appendix documents the set of fields and values
that come predefined with SignStream. The second appendix contains a listing of the words
that are reserved for searching and, thus, cannot be used elsewhere in the program. The third
appendix documents some keyboard and mouse shortcuts. Finally, the last documents the
format of the text file that is created when a SignStream database is exported as text.



Chapter 8: Menu items

This chapter describes the menus and menu items in SignStream’s main menu bar. Some of
these menu items have not yet been implemented and are marked with a ♦ in this
documentation.

File menu
Most items in the File menu are self-
explanatory. The close and save items in
the fourth grouping alternate between,
e.g., Close Database, Close Search, and
Close Script, depending on what kind of
window is front-most.

Saving a database: When a database is
saved to a disk file, the program saves
certain information about the current
“state” of the display: the windows that
are open, their size (except for video
windows) and position, and the internal
display state of all gloss windows (the
fields that are displayed and the ordering
of those fields). These states are restored
the next time the database is opened.
(The same is true when a search or script
is saved.)

Database Info allows you to view and
edit background information about the
database. See Getting information about
the database.

♦
♦

♦

Export Database As Text exports the information from the database into a tab-delimited plain
text format, as documented in Appendix D: Database export file format. Note that when a
script window is active, this menu item changes to Export Script Movie, which is described in
Chapter 7: Scripts.
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Create Sound File allows you to convert any QuickTime compatible file (containing an audio
track) to an AIFF file that can then be used as the audio file for an utterance. When you select
this item, an open dialog box appears, prompting you to select the movie to be converted.
Once you locate the movie and specify where to save the new sound file (it is recommended
that the name of the new file include the ".aiff" extension), the conversion will be performed.
Note that if the movie does not contain an audio track that can be converted, you will see an
error message.

Edit menu
This menu contains the following items: Undo/Redo, Cut, Copy, Paste, and Clear. Currently,
the Cut/Copy/Paste and Clear items operate only on text (e.g., you cannot Copy a non-manual
data item). There is a single level of Undo and Redo; that is, only the most recent action can be
either undone or redone. The following actions can be undone:

• Show Field and Hide Field.

• Creating a gloss or non-manual datum.

• Setting the start or end frame of an utterance or datum.

• Changing the value of a non-manual datum.

• Typing and Cut/Copy/Paste/Clear in gloss and free text fields.

• Setting the font, size, and style in free text fields.

• Deleting a datum.

• Deleting an utterance.

When the Delete Utterance menu item (found in the Utterance menu) is used to
delete the only open utterance, the database’s index window appears after the
utterance is deleted.

• Text editing operations in the Notes window.

• In the Search window: typing; operator, participant, and data insertion; and
(un)grouping.
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Utterance menu
The New/Open/Close/Delete and
First/Last/Previous/Next utterance
items are self-explanatory.

Renumber Utterances allows you to
renumber the utterances in the database
so that any gaps in the sequential
numbering are removed. This command
is useful if you have deleted any
intermediate utterances; it is only
enabled when the renumbering would
have some effect.

Note that your database is automatically
saved (after the renumbering is
complete) with the new numbering
scheme (the program warns you that this
will happen). For this reason, you may
want to make a backup copy of your
database before you renumber the
utterances.

Display Additional Participant adds an additional participant pane at the bottom of the gloss
window (without resizing the window) by borrowing the required vertical space from the
other participant panes. The user is prompted to select the additional participant that is to be
displayed in the new pane. The gloss window must be large enough to accommodate the
additional participant pane; if it is not, then no change is made to the display and the user is
instructed to first resize the window.

Hide Non Primary Participants removes from the active gloss window display any participant
panes corresponding to non-primary participants. The primary participant will then be the
only visible participant (if the primary participant was previously hidden, it will be displayed).
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Hide Field removes the selected field from the gloss window display (it does not delete any data).
A field must be selected or activated for editing for this menu item to be enabled. You can also
hide a field by option-clicking its label. Note that the main gloss and non-dominant hand gloss
fields cannot be hidden.

Hide Empty Fields removes from the gloss window display any fields that do not contain data (as
if you had selected Hide Field for each empty field).

Set Field Value allows you to change the value of a non-manual item. You must first select the
non-manual item you want to change. You can also change a non-manual item’s value by
selecting it and then clicking on its value label above the item’s line in the gloss window.

Media Controller opens the media controller window.

Media info displays information about an utterance’s media, such as name, location, duration,
data size, data rate, and copyright. When a video window is frontmost, this menu item is
enabled and appears as Movie Info.  When an audio window is fronmost, this item is enabled
and appears as Audio Info.  When neither a video nor an audio window is frontmost, this item
appears as Media Info and is disabled.

Open Notes opens the notes window associated with the active utterance.
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View menu
The view menu provides access to
various tools.

Media alignment Indicator: expands into
a submenu of three possible display
behaviors: Show (always), Hide (always),
and Show only when (the media are)
stopped. On this third setting, the media
alignment indicator will not be displayed
as the media are playing (the indicator
will not scroll across the gloss window).

Field Specifications Editor: Selecting this menu item opens the field specifications editor,
discussed in Chapter 5: Modifying field and field value definitions.

Participants Editor: Selecting this menu item opens the participants editor, discussed in
Chapter 4: Working with multiple participants.

Zoom Wave Form In/Out: Selecting these menu items when an audio window is active will
zoom the display of the audio wave form in and out (showing more or less detail).

Text menu
The items in the Text menu allow you to change the type characteristics of text. Currently, you
can change the font, size, and style of text in text-type fields only (not in non-manual or gloss
fields). You can also change the font, size, style, and alignment of text in the notes window. In
subsequent implementations of the program, you will be able to change the font that is used
in other fields, such as the main gloss field.
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Windows menu
The Windows menu provides items for
manipulating open windows. The
bottom section of the menu contains a
list of all open windows in the order in
which they appear on screen from front
to back; the active window is the one
designated by the √ mark. Selecting one
of the items in this list will cause the
associated window to become front-most
and active. Selecting the Close Window
or Zoom Window menu items yields
the same results as clicking in the close
box or zoom box of the active window.

Restore Default Movie Size is enabled if a video window is active and it has been resized from
its initial dimensions. Selecting this item will cause the video window to return to those
initial dimensions. Pressing the option key while clicking in a video window’s zoom box or
while selecting the Zoom Window command from the Windows menu accomplishes the
same thing.



Appendix A: Fields and values

This appendix documents the fields and values that are predefined as part of SignStream.

Gloss fields
Gloss fields contain time-aligned text. SignStream comes with two predefined gloss fields: the
main gloss field and the non-dominant hand gloss field. These can be used for coding activity
of the dominant and non-dominant hands, respectively. These two fields are always
displayed.

While individual researchers and transcribers can, of course, use whatever notations they
find useful within the gloss fields, we offer the following list of conventions for coding sign
language data in the interest of establishing consistency in notation and to facilitate the
sharing of data. The glossing conventions suggested here, as well as the non-manual fields
and values described later in this appendix, are based in large part on the notation systems
used in C. Baker and D. Cokely,      American Sign Language–A Teacher’s Resource Text on
Grammar and Culture     (Silver Spring, MD: T.J. Publishers, Inc. 1980) and C. Smith, E. M. Lentz,
and K. Mikos,     Signing Naturally: Teacher’s Curriculum Guide, Levels 1 and 2     (San Diego, CA:
DawnSignPress 1988). The notations are intended to be descriptive, rather than to express
particular theoretical beliefs. For example, notation is provided for 1st, 2nd, and 3rd person
reference, despite the fact that questions have been raised about whether the distinction
between 2nd and 3rd person is grammatically significant in ASL.

capital letters GLOSS (English word).

: Coindexation/Agreement. Examples: i:GIVE:j, JOHN:i, JOHN IX:i

- When one sign corresponds to multiple English words, - is used to
separate the words. Examples: OH-I-SEE, THANK-YOU [note: - is also used
elsewhere]

fs- Fingerspelled words. Example: fs-JOHN

# Fingerspelled loan signs. Examples: #CAR, #EARLY

 ̂ Contractions. Example: NOT^HERE

+ Compounds. Example: MOTHER+FATHER

/ Used when one sign has two different English equivalents.
Examples: BOLD/TOUGH, REAL/TRUE
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“ ” Quotation marks around lower-case words (which may include spaces)
indicate a gesture-like sign. Examples: “wave no” “wave left”. This
notation is also used in descriptions of classifiers. Examples: DCL:“curly
hair”, SCL:1“person walking stiffly and hurriedly”

! ! Emphatic forms. Examples: !BORED!, !MUST!

++ Indicates repetition of a sign. The number of + signs indicates the number
of repetitions, e.g., DIFFERENT++ indicates 2 repetitions (i.e., the sign was
made a total of 3 times). Examples: GO++, SEE+

( ) Words in ( ) indicate an action or movement made without a sign,
sometimes with linguistic meaning. Example: (nod), (shake head), (draws
shape)

GLOSS-aspect Aspect. The user can type in whatever aspect is appropriate. Example:
STUDY-continuative

(2h)GLOSS For two-handed signs. It is used when a sign that is commonly one-
handed is made with both hands. Example: (2h)#DO++

(2h)alt.GLOSS The symbol “alt.” indicates that both hands move in an alternating
manner. Example: (2h)alt.GUESS

> This symbol is used to represent a hand position that is held at the end of a
sign. For example, after signing fs-JOHN, the signer might hold the last
element of that sign (namely, the N handshape). This same diacritic can be
used to indicate perseveration of the non-dominant hand.

Example glosses for indexes and locatives:

IX-1p POSS-1p SELF-1p
IX-2p POSS-2p SELF-2p
IX-3p POSS-3p SELF-3p
IX-2p-pl-arc POSS-2p-pl-arc SELF-2p-pl-arc
IX-3p-pl-dual POSS-3p-pl-dual SELF-3p-pl-dual
IX-loc“under table” IX-dir“around the corner to the right”

With coreference indication, these might look like:

IX-1p:i IX-3p:j
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Example glosses for classifiers:

DCL“curly hair” ICL“turn crank”
LCL:B“leaf drifting to the ground” (2h)BPCL:1“crossing legs”
SCL:1“person walking stiffly and hurriedly” BCL“put arms around friend”
PCL:3“people walking” ECL:5wg“waterfall”

Text fields
Text fields contain textual information that is not aligned to the video. The two text fields that
come predefined with SignStream are the “literal translation” field and the “English
translation” field.

Non-manual fields
The non-manual fields that come with SignStream fall into two categories.      Anatomical fields   
refer to particular physical muscle movements.     Functional/ interpretive fields    (e.g., wh
question, topic) provide a functional interpretation for a particular movement or set of
movements. This section first describes the anatomical fields, then the
functional/interpretive fields.

Each field is specified as follows:

Field name  (field label, if different from field name)  [field prefix, if any]
value1 name (value1 label, if different from name)
etc.

Limited textual explanation of some of the fields and values is also provided.

Not all fields have predefined values (the role shift field is one that does not). Those non-
manual fields that do have predefined values also include a “start” and an “end” value for
coding the beginning (anticipatory or onset) and ending (coda) portions of a non-manual
event, although these values are not explicitly listed. Demonstrations of the use of start and
end values can be found in the sample database.
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Anatomical fields

Fields for head movements

In order to allow for coding of the complex motions in which the head may engage,
SignStream includes 8 fields for head behavior: 4 head     position     fields, for cases where the
head is held in a non-neutral position, and 4 head       movement    fields, for continuous
(repeated) movements. The movement and position fields are organized in parallel fashion,
such that each field captures motion along a particular dimension. For example, the head can
move along one of the three axes schematized in the diagrams below.

X Z

Y Y

Thus, we can identify movements of the head that involve rotation with respect to these axes.
When the head shakes or assumes a turned position, it is rotating around the Y axis. When
the head tilts forward or backward, nods, or assumes a raised or lowered position, it is rotating
around the X axis. When the head moves side to side, it is moving around the Z axis.

In addition, the head may be displaced by moving its base, that is, the neck. In this way, the
head may jut forward, for example. There are two fields, a position field and a movement
field, for capturing this kind of motion.

Head position    : For the head position fields, the head first moves to a target position and then
maintains that position. We have generally transcribed the movement portion as “start”, and
the held portion as some particular value (left, right, etc.).

head pos: tilt fr/bk  (hp: tilt fr/bk) [X axis]
front
back
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head pos: turn  (hp: turn) [Y axis]
left
right

head pos: tilt side  (hp: tilt side) [Z axis]
left
right

head pos: jut  (hp: jut) [base]
forward  (for)
forward/left  (for/left)
forward/right  (for/rt)

Head movement   : The head movement fields generally describe repetitive head movements.

head mvmt: nod (hm: nod) [X axis]
rapid
slow
single

head mvmt: shake (hm: shake) [Y axis]
rapid
slow
single

head mvmt: side to side (hm: side<->side) [Z axis]
rapid
slow

head mvmt: jut  (hm: jut) [base]
slow

Other anatomical fields

body lean
left
right
forward (for)
back
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shoulders
left
right
forward (for)
back

eye brows
raised
lowered

eye gaze [eg:]
[there are no predefined values; values are defined as needed]

eye aperture (eye apert)
blink (bl)
squint (sq)
wide

nose
wrinkle (wr)

mouth
lips pursed: oo (oo)
lips pursed: oo-tight (oo-tight)
lips pursed: mm (mm)
raised upper lip (rul)
tongue sucked in quickly (thp)
tongue mvmt lateral (tml)
cha
sta
puh
pow
cs
intense (int)
open
tongue out (th)
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cheeks
puffed (puf)
tensed (tns)

Functional/interpretive fields
negative (neg)

neg

wh question (whq)
wh

yes/no question (yes/no)
y/n

rhetorical question (rhq)
rhq

topic
top1
top2
top3

conditional/when (cond/when)
cond
when

role shift (rs) [rs:]
[there are no predefined values; values are defined as needed]

face orientation  (face orient) [fo:]
[there are no predefined values; values are defined as needed]

subject agreement (subj agr)
agr-S
agr-dS

object agreement (obj agr)
agr-O
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adverbial (adv)
far
cs
stress
mm
oo
cha

Fields for parts of speech
There are two fields for coding part of speech information. The first field (POS) includes part
of speech “tags” that should be familiar to linguists, while the second field includes tags from
the set established by the Linguistic Data Consortium (http://www.ldc.upenn.edu/). Users
can edit or add to these tags as needed.

POS
Noun  (N)
Proper Noun  (PN)
Pronoun  (Pro)
Determiner  (Det)
Quantifier  (Quant)
Wh-word  (Wh)
Number  (Num)
Negation  (Neg)
Verb  (V)
Adjective  (Adj)
Adverb  (Adv)
Preposition  (Prep)
Modal  (Modal)
Tense Marker  (Tense)
Classifier  (CL)
Conjunction  (Conj)
Particle  (Prt)
Discourse Marker  (DM)

LDC POS
Coord Conj  (CC)
Cardinal Number  (CD)

http://www.ldc.upenn.edu/
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Determiner  (DT)
Existential there  (EX)
Foreign Word  (FW)
Prep or Sub Conj  (IN)
Adjective  (JJ)
Adjective, comp  (JJR)
Adjective, superl  (JJS)
List item marker  (LS)
Modal  (MD)
Noun, sg/mass  (NN)
Noun, plural  (NNS)
Proper Noun, sg  (NNP)
Proper Noun, pl  (NNPS)
Predeterminer  (PDT)
Possessive ending  (POS)
Personal Pronoun  (PRP)
Possessive Pronoun  (PRP$)
Adverb  (RB)
Adverb, comp  (RBR)
Adverb, superl  (RBS)
Particle  (RP)
Symbol  (SYM)
to  (TO)
Interjection  (UH)
Verb, base form  (VB)
Verb, past tense  (VBD)
Verb, gerund/pres part  (VBG)
Verb, past part  (VBN)
Verb, non-3p sg pres  (VBP)
Verb, 3p sg pres  (VBZ)
Wh-determiner  (WDT)
Wh-pronoun  (WP)
Possessive wh-pronoun  (WP$)
Wh-adverb  (WRB)



Appendix B: Reserved words and characters

Several words and characters are reserved for use in search queries. The list of reserved words
and characters can be viewed from within the program by selecting SignStream Help from the
Apple menu.

Reserved words cannot be used as the name or label (short name) of a participant or field.
Reserved characters cannot appear within any name or label of a participant, field, or field
value.

Reserved words:

and
or
with
not
before
after
startframe
endframe
framed
unframed
participant
gloss-field
non-manual-field
Notes
-wholeword
-matchcase

Reserved characters:
[
]
*



Appendix C: Keyboard and mouse shortcuts

This appendix documents some of the available keyboard and mouse shortcuts.

Program launch key combinations

If you hold down the    command     key while the program is starting up, you will be presented
with an open database file dialog instead of a new untitled database. If you hold down both the
command and option     keys, you will not be presented with anything: neither the open
database dialog nor a new untitled database.

Arrow keys

When the active window is a video window:

(The ↑ ↓ keys don't affect the movie’s playback speed setting as they did in earlier versions.)

When the movie is not playing, the → and ← keys advance or rewind the movie by single
real frame increments; other open media are updated as well.

When the active window is an audio window:

The ↑ and ↓ keys zoom the sound wave display out and in, respectively. The → and ← keys
shuttle the media alignment indicator to the beginning and end, respectively, of the
display (other open media are updated as well).

When the active window is a gloss window:

In Utterance mode, the → and ← keys advance or rewind the movie to the next movie
frame that is coded in the gloss window.

The ↑ and ↓ keys position the movie at the beginning or the end of a selected item. The →
and ← keys move the text caret within text fields that are activated for editing, such as the
main gloss field or the English translation field. Holding down the shift key while using

the → and ← keys within a text field will extend the text selection between the old text caret
position and the new one.
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When the active window is a notes window:

The arrow keys move the text caret within the text in the notes window. Holding down
the shift key while using the arrow keys will extend the text selection between the old text
caret position and the new one.

Modifier key/mouse combinations

Command-click and drag on a window’s title bar: If you command-click on the title bar of a
SignStream window that is in the background (not active), you can drag this window to a
different location without activating it (unless an open or save file dialog window is open).

Option-Zoom: Holding the option key while clicking in a video window’s zoom box or while
selecting Zoom Window from the Windows menu will restore the video window to its
default size. See also Restore Default Movie Size.

Option-Next/Previous/First/Last Utterance: Holding down the option key while selecting one
of the navigation commands (Previous Utterance, Next Utterance, First Utterance, Last
Utterance) from the Utterance menu will, in addition to opening the appropriate utterance,
close the active utterance.

Option-click on field label: You can hide a field in the gloss window by option-clicking on its
field label (at the left edge of the gloss window).

Option-enter in gloss window: When a gloss window is active, typing option-enter will cause
the selected or active field (if any) to be scrolled into view. In addition, any selected datum
within that field will be scrolled into view.

Option-Play Clip: Option-clicking the Play Clip button while the movie is playing causes the
movie to stop.

Control-Play Clip: Control-clicking the Play Clip button causes the movie to go to the start
frame of the selected item and stop.

Command-Play Clip: Command-clicking the Play Clip button causes the movie to go to the
end frame and stop.

Search window: there are several key combinations available in the search window.

•  Option-clicking on the Search button executes the search for this and all subsequent
stages.
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•  Option-clicking on a contracted results triangle expands the results for this and all
subsequent stages. Similarly, option-clicking on an expanded results triangle contracts the
results for this and all subsequent stages.

•  Command-clicking in the search domain display area causes the information to toggle
between a file name and a full path name.

Shift-Play Media:  In order to optimize media play quality, SignStream will normally try to load
as much media data as possible from open media files (if there is more than 1) into RAM before 
playing the media.  This can sometimes result in a delay before the media start playing.  If the shift 
key is being held down at the time the program would ordinarily begin loading the media data 
into RAM (e.g., when a gloss window’s Play Clip button is clicked or when a media player 
control bar’s play button is cliecked), the program will not attempt to load those media data into
 RAM, but will, instead, just play the media directly from the media files.  This will make the play 
begin immediately, but at times might also result in choppier play quality.

Command-n/N: In most cases, this key command creates a new utterance.  However, in the
following circumstances, it creates a different kind of new entity:

•  In the participants selector window, command-N creates a new participant.

•  In the participant editor, command-N creates a new participant.

•  When editing a non-manual field, command-N creates a new field value.

Other keyboard commands

When the active window is an audio window:

Striking the Enter key will scroll the display so that the media alignment indicator is
brought into view and, if possible, centered in the window.



Appendix D: Database export file format

This appendix documents (version 5 of) the format of the text file that is
produced when you choose Export Database As Text from the File menu.

All data in SignStream export files are delineated by tabs and carriage returns.
The carriage returns indicate where a unified group of data begins and ends and
the tabs indicate where each individual datum begins and ends. Thus, export
files can be readily viewed in spreadsheet programs (or text editors used by
programmers for writing source code).

The appendix first provides a schematic description of the export file format.
Next follows a sample exported file based on the sample database, although only
the data for the first two utterances are included.

Schematic description of export file format
The following conventions are used in the description below:

Double quotes surround specific constant labels.
Angle brackets surround tabs and returns.
Square brackets surround variable data descriptions.
Parentheses surround explanations of variable data descriptions.
All number data are saved as ASCII numeric characters, not as binary codes.

Export format version 5

"SIGNSTREAM EXPORT DATA FILE" <return>
"Export data format version:" <tab> [the version number] <return>
"Database:" <tab> [the database file name] <tab> [the database file path name] <return>
"Number of utterances:" <tab> [number of utterances] <return>
<return>
<return>
"Utterance ID:" <tab> [1st utterance's ID] <return>
"Media:" <return>
"Number of video file slots:" <tab> [number of movie file references (unselected references
are blank)] <return>
"Number of audio file slots:" <tab> [number of audio file references (unselected references
are blank)] <return>
"Video" <tab> [1st video slot's file path name (blank if unselected)] <return>
"Video" <tab> [nth video slot's file path name (blank if unselected)] <return>
"Audio" <tab> [1st audio slot's file path name (blank if unselected)] <return>
"Audio" <tab> [nth audio slot's file path name (blank if unselected)] <return>
"Start frame:" <tab> [utterance start frame] <return>
"End frame:" <tab> [utterance end frame] <return>
"Number of participant panes:" <tab> [number of panes] <return>
"Participant:" <tab> [1st participant's full name] <return>
"Number of fields:" <tab> [number of fields in pane] <return>
[1st field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
[nth field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
"Participant:" <tab> [nth participant's full name] <return>
"Number of fields:" <tab> [number of fields in pane] <return>



[1st field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
[nth field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
"Notes - number of character bytes:" <tab> [number of character bytes] <return>
[text of notes (if there is no notes text then there are three returns between the number of
character bytes indicator and the next utterance)] <return>
<return>
<return>
"Utterance ID:" <tab> [nth utterance's ID] <return>
"Media:" <return>
"Number of video file slots:" <tab> [number of movie file references (unselected references
are blank)] <return>
"Number of audio file slots:" <tab> [number of audio file references (unselected references
are blank)] <return>
"Video" <tab> [1st video slot's file path name (blank if unselected)] <return>
"Video" <tab> [nth video slot's file path name (blank if unselected)] <return>
"Audio" <tab> [1st audio slot's file path name (blank if unselected)] <return>
"Audio" <tab> [nth audio slot's file path name (blank if unselected)] <return>
"Start frame:" <tab> [utterance start frame] <return>
"End frame:" <tab> [utterance end frame] <return>
"Number of participant panes:" <tab> [number of panes] <return>
"Participant:" <tab> [1st participant's full name] <return>
"Number of fields:" <tab> [number of fields in pane] <return>
[1st field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
[nth field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
"Participant:" <tab> [nth participant's full name] <return>
"Number of fields:" <tab> [number of fields in pane] <return>
[1st field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
[nth field name] <tab> [1st value's name] <tab> [start frame] <tab> [end frame] <tab> [nth
value's name] <tab> [start frame] <tab> [end frame] <return>
"Notes - number of character bytes:" <tab> [number of character bytes] <return>
[text of notes (if there is no notes text then there are three returns between the number of
character bytes and the next utterance)] <return>

Sample export file     (data for first two utterances shown here)

SIGNSTREAM EXPORT DATA FILE
Export data format version: 5
Database: NCSLGR dataset 1 SignStream 2.0 CD:NCSLGR ƒ:NCSLGR dataset 1
Number of utterances: 32

Utterance ID: 1
Media:
Number of video file slots: 4
Number of audio file slots: 1
Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:master-compressed:ch4-
397_242_small_0.mov
Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:slave1-compressed:ch4-
397_242_small_1.mov



Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:slave2-compressed:ch4-
397_242_small_2.mov
Video
Audio
Start frame: 0
End frame: 1320
Number of participant panes: 1
Participant: Norma Bowers Tourangeau
Number of fields: 009
main gloss IX-1p 140 180 SEE 340 380 fs-JOHN       440 540 

YESTERDAY     660 780 IX-3p:i 940    980
non-dominant hand gloss
head pos: jut start 120 260 back 280 940 end 960 1060
head pos: tilt fr/bk start 680 760 front 780 920 end 940 1100
head pos: tilt side start 80 300 right 320 940 end 960 1140
nose start 40 100 wrinkle       120 140 end 160 200
eye aperture wide 280 380
POS Pronoun140 180 Verb 340 380 Proper Noun 440 540 Adverb 660

780 Pronoun       940 980
English translation I saw John yesterday, him.
Notes - number of character bytes: 44
IX-3p can also be read as IX-loc"over there"

Utterance ID: 2
Media:
Number of video file slots: 4
Number of audio file slots: 1
Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:master-compressed:ch4-
398_243_small_0.mov
Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:slave1-compressed:ch4-
398_243_small_1.mov
Video SignStream 2.0 CD:NCSLGR ƒ:All the compressed videos:slave2-compressed:ch4-
398_243_small_2.mov
Video
Audio
Start frame: 20
End frame: 1320
Number of participant panes: 1
Participant: Norma Bowers Tourangeau
Number of fields: 010
main gloss LOVE 340 400 fs-MARY 520 660 |>760 fs-JOHN    840

1000 IX-loc:i 1040 1120
non-dominant hand gloss
topic top2 200 660
body lean forward       20 20 end 40 240
head mvmt: nodsingle 200 660 end 680 800
head pos: tilt side start 160 460 right 480 660 start 680 1000 left

1020 1140 end 1160 1320
eye brows raised 20 660 end 680 780
eye aperture start 20 180 wide 200 660 end 680 700 blink 720

740
POS Verb 340 400 Proper Noun 520 760 Proper Noun 840 1000 Adverb

1040 1120
English translation As for loving Mary, John (does).
Notes - number of character bytes: 0
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Appendix E: Tips for using SignStream

Memory allocation

The application on the CD-ROM specifies that 10 megabytes of RAM be allocated to the
program. However, you may wish to increase the memory allocation, particularly if you
will have multiple video windows open at the same time or if you receive an error
message while working with SignStream that indicates insufficient memory.  To do this,
copy SignStream from the CD-ROM onto a local hard disk.  Then, select the SignStream
application (while it is not running) and choose ‘Get Info’ from the Apple File menu. 
This will allow you to change the minimum and preferred memory allocation for that 
copy of the program.

If you try to create or open a database, utterance, or media display window while media
files are playing, an error message might inform you that there is insufficient memory to
do so.  In that case, stop the media (or wait until the media have finished playing on their
own) and then try again.

Working with movie files in different locations

SignStream database files include information about the media files associated with each
utterance. This creates some complications when movie files are moved to different
locations.  The program makes internal use (invisible to the user) of standard Macintosh
aliasing when storing the names and locations of media files and when attempting to
locate those files in order to open and display them.  If the application is unable to
locate a media file with the expected filename or in its expected location it will look in two
alternate directory locations for a substitute media file with the expected filename.
(Note: it will not look within subdirectories of those alternate directory locations.)
The first alternate location it will check is the directory that contains the database file.  If a
substitute is not found there then it will look in the directory that contains the running
SignStream application itself.  If the program does not find a media file with the expected
filename in either of the alternate directory locations, but its aliasing indicates a file with a
different filename in the original expected location, the user will be asked whether this is
the file that should be used. (Warning: if you move files to a different computer, the
aliasing may identify a completely different file from the one that is desired.)

So, if you are going to move media files to different locations, keeping the media files (or
Finder aliases to the media files) immediately within the same folder as the application or
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the database file will ensure that the media files will be properly located as utterances are
opened.

Using CD-ROMs (e.g.) to store media files

Since media files can be quite large, it is often useful to store them on CD-ROMs. This can
create some complications for the reasons described above.

If you are working with a database file on your local disk but wish to access media files that
reside on a CD-ROM (e.g.), then you can simply select movie files located on the CD-ROM
via the media controller window.  (If the media files were previously in a different location,
you will need to reselect the media files by holding down the option key while you click on
the “select” button in the media controller.)

As mentioned earlier, you may also create Finder aliases of the media files accessed by the
database file and put them in the same directory as the database file.  If the originals reside
on a CD-ROM, you will be prompted to insert the appropriate CD-ROM.

Using CD-ROMs (e.g.) to store database files as well as media files

If you wish to produce a CD-ROM that includes a SignStream database file with links to
media files that are on the same CD-ROM—but neither those media files nor aliases
pointing to those media files are located in the same directory as the database file
itself—this can be done in a two-step process.  First, create a folder on your local disk that
will contain exactly the set of files you will subsequently write to a CD-ROM (i.e., the
SignStream database file(s) plus the media files plus anything else that will be on that
CD-ROM). Then write out the CD-ROM that contains those files.  Next, put the newly
written CD-ROM in the CD-ROM drive and open the original database file from your local
disk.  Select (or reselect) the media files so that the database looks for movie files on the
CD-ROM.  Then write out that same set of files (including the updated database file) to
another new CD-ROM. Voilà. You now have on the 2nd CD-ROM a database file that
points to other files on that same 2nd CD-ROM. Please note, however, that if you add
other material to the new CD-ROM, the alias mechanism will not work properly and the
media files that you have linked to the utterances in your database file may not be
properly located.

The simplest situation, however, is to put the media files (or Finder aliases pointing to
those files) in the same directory as the database file that refers to them.  In that case, the
proper media files will be found, even though they are in a different location from the
media files that were originally selected.
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Warning: do not use PC-formatted disks!

If you copy SignStream databases onto other media such as floppy disks or Zip disks,
make sure that the media are formatted for Macintosh.  If you copy a SignStream database
onto a PC-formatted disk, the "resource fork" information will be lost. SignStream cannot
work properly with a database that has no resource fork.
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